RUNNING A FULLY AUTOMATED TRIAXIAL TEST
USING LOADTRAC-II/FlowTrac-II, AND TRIAXIAL SOFTWARE
(After Geocomp Corporation: TRIAXIAL User’s Manual, Copyright © 1982‐2010)

It should be noted that this is a VERY BRIEF overview on how to perform a triaxial test using the TRIAXIAL software, the FlowTrac and the LoadTrac. Any uncertainties should be clarified by consulting the User’s Manual.
It is assumed that the user has read the manual titled “RUNNING AN INCREMENTAL LOAD CONSOLIDATION TEST USING LOADTRAC II AND ICONP SOFTWARE” and is familiar with the operation of the LoadTrac device and the ICONP software. To request a copy of this manual, contact Dr. Dimitrios Zekkos at zekkos@umich.edu.

1. ENSURE THE SYSTEM IS RUNNING PROPERLY:

The following steps assume the system has been set up according to the instructions provided in the LoadTrac and FlowTrac User’s Manuals.

1.1. Examine the front panel of the LoadTrac and the two FlowTrac devices:

· The power lights for both Motor Power and CPU Power should be on for all three devices.
· Both network TX/RX lights should be on and green for all three devices.
· In the right column of the FlowTrac, both in and out flow lights should be off.

If the network lights are quickly alternating between green and red, this means the device is not communicating with the PC. Often times restarting the PC is sufficient to fix the problem, however if there are still communication errors between the LoadTrac and the PC see APPENDIX C of the LoadTrac
User’s Manual, APPENDIX C of the FlowTrac User’s Manual, APPENDIX F of the TRIAXIAL User’s Manual, or APPENDIX B of the Diag.Com20 User’s Manual.

1.2. Open the TRIAXIAL software and load a template file (Go to file >>Open>>template.dat)

· Open View >> System and then Control >> Load and position these windows such that you can see both. The readings on the System Monitor window for engineering units should all be at or near zero, assuming there is no load, displacement or pressure being introduced to the system.
If these values are significantly off, see page 24 of the TRIAXIAL User’s Manual
(Calibrate Menu) and also refer to APPENDIX A: Calibration.

*Warning* Great care should be taken when altering the calibration factors and offsets. Incorrect values can cause the system to apply the wrong forces and equipment damage is possible.

· BE CERTAIN NOTHING IS ON THE PLATEN. Enter a load value into the Load Control window that it is greater than that shown on the System Monitor window and click Go.
The green Motor Up LED should come on, indicating the platen is moving up. Click Stop to stop the platen’s movement.
Again click Go, but this time let the motion continue. The platen should reach its maximum height when the bottom of the platen is about 4.1” above the surface of the LoadTrac enclosure and the Upper Limit LED should flash.

Next, on the Load Control window enter a load value less than that shown on the System Monitor window and click Go. The green Motor Down LED should come on, indicating the platen is moving down. Click Stop to stop the platen’s movement. Again click Go, but this time let the motion continue. The platen should reach its minimum height when the bottom of the platen is about 0.75” above the surface of the LoadTrac enclosure and the Lower Limit LED should flash.

· Click anywhere on the System Control window to activate it. Use your hand to push on the bottom of the load cell. You should observe an increase in the load reading by a small amount (≈20 LBS).

· Observe the displacement reading on the System Monitor window as you move the displacement transducer shaft down, then let it come back up. The reading should change as you move the shaft. Below is a picture of the displacement transducer shaft (Figure 1).
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Figure 1: Displacement Transducer Shaft

· Bring down the View menu and click System to open the System Monitor window. Next, click Cell Pressure in the Control menu to open the Cell Pressure Control window. Finally, click Valves in the Control menu to open the Valves Control window.

· Position the windows so that they are beside one another. For each FlowTrac-II unit put the supply tube in a container of de-aerated water and the output tube in an empty container.

*WARNING* Do not run a flow pump without water in the cylinder. Dry operation can damage the seal around the flow pump piston.

· On the Valves Control window, in the Cell Pressure section, click the Supply Valve Close button and the Output Valve Open button. The Output Valve light on the front panel should be glowing yellow and the Supply Valve light should be off. Look at the Cell Pressure reading (in counts) on the System Monitor window. On the Cell Pressure Control window, enter a value in the left-hand text field that is about 500 counts more than that on the System Monitor window. Click the Go button on the Cell Pressure Control window. You should hear the FlowTrac-II unit making a slight sound and see the green Flow Out LED come on while water is being pushed out of the pump. Click the Stop button to stop the pump. Again, click the Go button but this time let the motion continue. When the pump is completely empty, the pump will stop and the Limit Empty LED will flash on and off showing that the end-of-range limit switch has been triggered. 

· On the Valves Control window, in the Cell Pressure section, click the Supply Valve Open button and the Output Valve Close button. The Output Valve light on the front panel of the cell pressure FlowTrac-II unit should be off and the Supply Valve light should be glowing yellow. Look at the Cell Pressure reading (in counts) on the System Monitor window. On the Cell Pressure Control window, enter a value in the left-hand text field that is about 500 counts less than that on the System Monitor window. Click the Go button on the Cell Pressure Control window. You should hear the FlowTrac-II unit making a slight sound and see the green Flow In LED come on while water is being drawn into the pump. Click the Stop button to stop the pump. Again, click the Go button but this time let the motion continue. When the pump cylinder is completely full, the pump will stop and the Limit Full LED will flash on and off showing that the end-of-range limit switch has been triggered.

· Click on the System Monitor window to activate it. Leaving the output valve open and the input valve closed, observe the reading for Cell Pressure as you raise the output tube above your head and lower it to the floor. You should see the value increase/decrease over a range of about 200 counts. 

· Replace the Cell Pressure Control window with the Sample Pressure Control window. Repeat the pump filling and emptying procedure for the FlowTrac-II unit that will control the sample pressure. 

If the system behaved as described above, you have successfully completed the check for your LoadTrac-II/FlowTrac-II system. 

2. SYSTEM SETUP:

2.1. ZEROING THE LOAD CELL

It is important to be sure that the load cell is zeroed before starting every test. To do this, go through the following procedure.
· Be certain the load cell is not in contact with anything.
· Bring down the View menu and select System to open the System Monitor window
· Bring down the Calibrate menu and select Summary to open the Calibration Summary window. Position this window beside the System Monitor window.
· Note the Load reading in counts on the System Monitor window (top left dialog box) and compare it to the Offset value on the Calibration Summary window (be sure Load is selected for the Channel choice).
· If the values differ by two or more counts, replace the Offset value with the Load reading.
· Click the Apply button, the Download button and then the Ok button to close the Calibration Summary window. 
· The Load reading in engineering units on the System Monitor window (top right dialog box) should now be zero.

2.2. BLEEDING THE LINES

· Go to the Position menu on the cell FlowTrac LCD
· Press 1 on the keypad to select Empty and then press Ent.
· [bookmark: _GoBack]When you see water beginning to come out of the supply line, visually inspect the line and continue pushing water out until you get rid of all the air bubbles

Before connecting the system, the user must get the correct cell pressure offset value and enter it into the TRIAXIAL program.

· Press 5 while in the Position menu to open the Control Valves menu. Check that the output valve is open, and press 1 to open it if necessary.
· Open the System Monitor window of the TRIAXIAL program (View >> System Options)
· Open the Calibration Summary window (Calibrate >> Summary)
· Raise the end of the output line of the FlowTrac to the height corresponding to the mid-height of the specimen
· Record the pressure value (in counts) that is shown on the System Monitor window
· On the Calibration Summary window, select the Cell Pressure Channel and type the pressure value you recorded into the offset text field. Click Apply

Repeat the same process of bleeding the lines and correcting the offset value for the other FlowTrac (used to control the sample)

2.3. CONNECTING THE SYSTEM

· Make sure there is no air gaps at the ends of both tubes.
· Connect the tube from the FlowTrac controlling the cell pressure to the quick-connect valve on the front of the base platen.
· Connect the tube from the FlowTrac controlling the sample pressure to the leftmost valve.
· Connect the two center valves together with a short tube
· For drained tests, Connect a tube to the rightmost valve to allow for drainage

3. RUNNING A TEST

3.1. DEFINING TEST PROPERTIES

The Properties Sheet is used to enter general information about the test, the physical characteristics of the specimen, and the test parameters. The Properties Sheet consists of ten Property pages; each designated by labeled tab and controls an aspect of the test. The ten properties are: Project, Specimen, Water Content, Read Table, Test Parameters, Initialization, Consolidation/A Table, Saturation, Consolidation/B Table, and Shear Table.

3.1.1. Project Page

Used to enter general information about the project and the specimen tested. The test does not use any of the information in this page, and it can be modified after a test is run. The information however, will appear on the report pages generated by the TRIAXIAL Software.

3.1.2. Specimen Page

Used to enter the physical parameters that describe the specimen to be tested. These parameters will be included in the report, and will be used to construct some figures. The Initial Diameter is used by the software to determine the stress applied during the test so it has to be an accurate value.

3.1.3. Water Content Page

Used to enter data related to the specimen water content before and after the test. These values do not control the test, but are used for reporting purposes.

3.1.4. Read Table Page

Used to control when the software reads and stores data during a test. It can be on the basis of Time, Strain, Displacement, or volume. Note that the desired control parameter is not chosen on this page as will be discussed later. Data will be read when values from the sensors match those in the Read Table for the chosen control parameters. 
In the column of the desired control, enter values at which you want the system to read and store values. You may enter a full set of values or as few as two values. The system will follow the pattern of the last two values and continue reading data until the test is stopped. 

3.1.5. Test Parameters Page

Used to select test-specific parameters like area correction type (if any) and to enter correction factors. It also allows the selection of the test’s starting phase, test type, and the ASTM standard to use. In addition, it allows the user to select when strength is shown.

3.1.6. Initialization Page

Used to apply the initial stress condition to the specimen without applying any vertical load. Use this phase to apply the confining stress before the load is applied. The Horizontal Stress is the confining stress applied to the specimen. The Vertical Stress is the confining stress plus any stress to be applied by the piston. Set the Vertical Stress to a value equal to the horizontal stress in order to not apply any load. Sample Pressure is the pore pressure and should always be less than the sample pressure. The Stress Rate determines how fast the pressure will build up to reach the target values. The initialization phase will end and the test will proceed to the next phase after the time specified in the Duration field has elapsed.
The Read Table field allows the user to select which of the Read Table columns will be used to control the recording of data during the initialization phase.


3.1.7. Consolidation/A Table

Used to control the consolidation phase prior to saturation. Refer to the manual titled “RUNNING AN INCREMENTAL LOAD CONSOLIDATION TEST USING LOADTRAC II AND ICONP SOFTWARE” for a detailed description of the consolidation table.

3.1.8. Saturation Table

Used to control the saturation phase of the test. This phase consists of incremental increases in cell pressure and pore pressure to achieve maximum saturation while maintaining a constant effective stress. The ratio of pore pressure increase to cell pressure increase is the saturation ratio or B value. 

The Pressure Increment is the amount by which the cell pressure and sample pressure are increased. The Pressure Rate is the rate at which the pressure increments are applied. TRIAXIAL will only accept positive values for those parameters. The system will continue to increase the pressure until it attains both the Minimum Cell Pressure and the Minimum Saturation Ratio.

If the system reaches the Maximum Cell Pressure with the former conditions not satisfied, it will start a cyclic process of decreasing and increasing the pressure and monitoring the B value. This process will continue until the Minimum Saturation Ratio is attained or the number of cycles exceeds the specified Maximum Number of Cycles. Note that when setting a value for the Maximum Cell Pressure, one must take into account the variations of pressure in the following phases. The total pressure should not exceed the pressure rating of the cell, the load cell, or the pressure transducers. 

T1 is the duration for which the applied cell pressure is maintained before pore pressure is checked. 

T2 is the duration at which the incremented pore pressure is maintained before the cell pressure is increased.

T3 is the duration, at the beginning of each cycle, between the decrease of cell and pore pressure and the increase of cell pressure.

T4 is used only if the Maximum Number of Cycles is exceeded without reaching the minimum B value. It is the time the program waits before beginning the next phase of the test.

Refer to page 44 of the User’s Manual for typical values for T1, T2, T3, and T4 and factors that affect their selection.

A common method used to improve the B-value is CO2 flushing. Flushing the  specimen with CO2  prior to saturating it replaces air in the voids with CO2 which is more soluble in water, thus helping in the saturation process. Please refer to the specimen preparation manual for instructions on how to perform CO2 flushing.


3.1.9. Consolidation/B table

Similar to the Consolidation/A table, except for the difference that it has the option of selecting K0 consolidation. 

3.1.10. Shear Table

Used to control the shear phase of the test. For a triaxial test, the Shear Table may consist of one or more rows of values. The Horizontal and Vertical Stress columns control the stress conditions experienced by the specimen. 

The Stress Type column controls how the program interprets the inputted stresses. If Absolute is selected under Stress Type, the values entered in the first two columns are the target stresses to reach. If relative is selected under Stress Type, the values entered in the first two columns are the increments in the stresses already applied to the specimen. Similarly, the values entered in the Pore Pressure Change column are interpreted based on the Stress Type and control the pore (sample) pressure. 

Shear Step Type is used to select the type of the triaxial test being run. The options are Drained, Undrained, and Absolute. Note that for Drained and Undrained tests, the value entered in the Pore Pressure Change column will be ignored. 

The Shear Step Control column decided whether the test will be controlled by the applied stresses or the axial strain of the specimen. The step will automatically stop when the stresses reach the target values or the strain reaches the maximum value entered in the Maximum Strain column. Note that for strain control to work properly, a non-zero value should be entered into the Vertical Stress column while zero values must be entered in the Horizontal Stress and Pore Pressure Change columns. The value entered in the Vertical Stress column can be a relatively large number. Roughly, it should be at least equal to the confining stress plus twice the anticipated shear strength.

The Rate column controls how fast the device applies the selected stresses or strain.

Use the Maintain Time column to have the program maintain the target stress or strain conditions for a specified time before ending the test or moving to the next step. 

The Read Table allows the user to select the times at which data is saved. This could be at specific time, strain, displacement, or volume values. 

3.2. PREPARING A SAMPLE

For general sample preparation procedure, refer to page 58 of the TRIAXIAL User’s Manual. For a detailed procedure on how to prepare a specimen of dry soil, see ***.

3.3. STARTING THE TEST

To start the test, select Start from the Run menu. The Save As window will show asking you to save the test file. Choose a name for the test file and click Save. 

The program will now ask if you would like to Initialize Flow Pumps. In this process, the two pumps are emptied and then refilled to the values specified in the Hardware Setup Menu (75% for the cell pump and 50% for the sample pump by default). You may have to change these values if you have a fairly porous specimen. Refer to page 65 of the User’s Manual for details on this topic.

When the pump initialization is done, click Ok to proceed. You will now have the option to position the platen. Use the keypad on the LoadTrac to move the specimen up as close as possible to the load cell but make sure you do not touch it. Click Yes and the platen will move up slowly until it touches the load cell. Note that you should not click Ok before the platen stops. Doing so would result in data being collected without any load being applied.

When the platen is positioned and you click Ok, the software asks you to unlock the piston. Turn the knob counter-clockwise until the piston can move freely. Click Ok to start the test. 

3.4. DURING A TEST

3.4.1. MONITORING TEST

While a test is running, you can view the data collected in real-time. Open the View menu and select one of the last three options (Test Monitor, Test Graph, or Test T100). 

The Test Monitor option shows a window that present the current status of the test in numeric form. The data is updated every second.

The Test Graph option shows a window that presents four graphs showing the data being collected. The graphs are also updated every second.

The Test T100 option is used for the consolidation phase. It shows a window that contains the plot of the displacement versus the square root of time and the construction required to determine T100. The window is updated every second.

3.4.2. MODIFYING A TEST

A test can still be modified while it is running. The user can modify the consolidation and shear tables, skip steps, or abort a test. To modify any of the tables, change the value of the desired cell(s), move the cursor to another cell on the table, and execute the Save command from the File menu. 

To skip a step or a phase, open the Run menu and choose Next Step or Next Phase. Next Step skips the current step within one phase while Next Phase skips all the remaining steps on one phase and moves to the next one. 

At any point, you can abort the test by going to Run menu and choosing Abort. Note that aborting a test does not result in data being lost.

In case of power loss or any other interruption to the test, it can be restarted by going to the Run menu and choosing Restart. When selected, you will be asked to select the test file to restart. Choose the same test file that was used for the original test since the new data will be appended to it. You will have to manually terminate the first increment after a restart because the time compression will be affected. 

3.4.3. ENDING A TEST

A test could either end automatically when the shear phase ends or manually if the user chooses to abort the test. 

*WARNING* Do not execute the Save or Save As commands when a test ends. This will result in all test data being lost. 

When the test comes to an end, a window indicating that the test has ended will appear. Click Ok to close this window. All loads and pressures will be maintained after a test ends. Open the File menu and choose Load. Now you can use the Save or Save As commands to save your data to the test file. It is crucial that you execute the Load command first.

3.4.4. DISMANTLING THE SPECIMEN

The tested specimen should be dismantled as soon as possible after the test is over. This allows for a more accurate water content measurement (if applicable). To dismantle your specimen, lock the piston and close the cell-pressure and sample-pressure valves. Remove the tubing from these two valves. Using the keypad on each of the two FlowTrac devices, open the supply valve to release the pressure. Now, lower the platen and move the specimen to where you want to dismantle it. Place the cell in a sink, and insert a nipple into the quick connect on the top to release the pressure. With the nipple in place, connect a tube to the quick connect valve at the bottom of the cell to drain it. Unlock the piston, loosen the knobs on top of the posts and remove them. Take measurements of water content (if applicable) at this stage. 

3.4.5. COMPLETING THE TEST

The last step is to go back and enter any missing data into the test file. This will mainly be data related to the water content of the specimen. After you enter all the data, execute the Save command.

A report can be generated for every test. A report can be in table form or graph form. To generate a report, go to the Report menu and click on graph or table. Then, choose the phase that you wish to generate a report for. You can generate reports for either the Shear or the Saturation phases.
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